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3DSHcer

* An end-user application for image
analysis and visualization

* An open-source environment for
software development

* A software platform that is both easy
to use for clinical researchers and
easy to extend for programmers
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www.slicer.org

3DSlicer [Seach ]

& " A multi-platform, free and open source software package for
Q 3DSlicer visualization and medical image computing
o

3D Slicer version 3 —

is a multi-platform L

» Contact Us

software running on

* Download

»For Users

Windows, Linux, rooenm

»*NCIA

»Publication DB
nd M X
[ » Slicer Community

»Source Code
»Licensing
»Mailing Lists
»Web Archive

Disclaimer

It is the responsibility of the user of 3DSlicer to comply with both
the terms of the license and with the applicable laws, regulations
and rules. Slicer is a tool for research, and is not FDA approved.
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3DSHcer

« This workshop uses the newest
release of 3D Slicer (version
3.6.2).

» Visit the Slicer download page
for Slicer 3.6 stable release, or for
Slicer nightly builds.

CTSA at RSNA 2010

!E> : A multi-platform, free and open source «
. 3DsI |Ce_r visualization and medical \maqe Com[ utmq

Download Reference  Feedback

Search

Slicer Wiki

About Slicer

» Introduction

» Acknowledgments
» Contact

esources
* Download

»For Users

» For Developers
» Commercial Use
»*NCIA
»Publication DB
»Image Gallery

» Slicer Community
» Source Code
»Licensing

» Mailing Lists
»Web Archive
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Tutorial Overview

3DSlicer

» Getting Started: Slicer3 Minute Tutorial

* Quantitative Measurement of Volumetric Change:
ChangeTracker Tutorial

* Quantitative Measurements for Functional Imaging:
PETCTFusion Tutorial

All Tutorial Datasets are located in C:\slicer_data

CTSA at RSNA 2010
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@ Slicer3 Minute Tutorial
=

3DSlicer

Part I: Slicer3 Minute Tutorial

Sonia Pujol, PhD
Wendy Plesniak, PhD

This tutorial is a short introduction
to the advanced 3D visualization
capabilities of the Slicer3 software
for medical image analysis.

It is designed to quickly build a
basic level of comfort with the
Slicer software.
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- Slicer3 Minute Tutorial

3DSHcer

e The Slicer3minute dataset is composed of
an MR scan of the brain and 3D surface
reconstructions of anatomical structures.

e The data are part of the SPL-PNL Brain
Atlas developed by Talos et al. The atlas is
available at:

http://www.spl.harvard.edu/publications/item/view/1265

CTSA at RSNA 2010
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@ Slicer3 Minute Tutorial: Launch the Application
=

M NO \ 3D Slicer Version 3.6.2
3DS | i Ce r File Eant  View Window Help Feedback
(]3| e I MEEE HolePehEEm O @ & -&
B Slicer i

Windows users:

“ Manipulate Shce View:

El@lj]l:]ﬁ@@ S@ @
Double-Click the Shortcutto ="
Slicer3.exe on the Desktop .

=
»,

ml

HRE
[ L_Jﬁ

@
H D)

or Select

Start ->All Programs ->Slicer3 3.5.2009-11-06->Slicer

Thursday, November 4, 2010



Slicer3 Minute Tutorial: Navigating the Application GUI

y Bl - - &=
s oo Menu & Toolbar
(i
The Graphical User
Interface (GUI) of 3D Viewer
Slicer3 integrates five = GU:
components: Sl
e the Menu Toolbar
e the Module GUI Panel = —————————
e the 3D Viewer Ee N N - M N
. the Slice Viewer 2 P P EEECT [o uuuuuu_J
 the Slice and 3D View
Controller E“D@hc@W
Vlgggntroller
° [l e = O
l_hl_ i [ioo
)

CTSA at RSNA 2010
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w

3DSlicer

The SlicerWelcome
module is the module
displayed by default.

This module gives an
overview of the GUI of
Slicer3, and data loading
& saving functionalities.

Thursday, November 4, 2010

Slicer3 Minute Tutorial: Welcome Module
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@ Slicer3 Minute Tutorial: GUI Basics

ano
3DSlicer

&l &

>

Expand or shrink the -

GUI panel with the
arrows at the frame
top, or by clicking and
dragging the vertical
separator

Expand or collapse ...

any sub-panel by
clicking on its grey
title bar.

w  Window +

[

3

Feedback

ro— aa=E

DS i . J—
Slicer \ALobe®™ ™

\ 3D Slicer Version 3.6.2
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Slicer3 Minute Tutorial:

3DSlicer

Load A Scene

Import Scene...

Select File-> Load Scene & oewemeess -
from the File menu 72 ada volume.. .
wint Add Transform... ste
" save ctil-s

™ Close Scene

¥ Ove
_~ baw Exit

.

llondrq Scenes & Data

Browse to the location of the
Slicer_data directory.

lsa-mo Scenes & Data

Select that directory and
select the Add To Favorites

IcCon e 2 B

This will make the directory
easier to find later...

CTSA at RSNA 2010

) PETCT
) PETCT_Yap1

) PETCT Yap2

) FienaarGrant

) PNL-Normal-Subjects
) ProfilingTest

) Prostate

) ptest

) RECIST-TutorialData
) RonData

) Ronstest with 4

@& Slicer_data

\ 3D Slicer Version 3.6.2

Fee- BREEREOEYESE B E & 1S

| m = - “fﬁ]

] Select File
N MM ¥=)

»
K () ChangeTracker2009

) PETCTFusion-TutorialData
) Slicer3Minute

Modified ti
Mon Sep 13 12:48:40 201
Thu Aug 19 12:40:34 201
Wed Dec 16 18:31:58 200

) Change Tracker2009 ’ p
' ) Slicer3Minute ‘
-‘ - N I
Q runlbeis _ 7
N 1 = | -~
File name: I Open
Files of type: IScenes .mrml xml xcat) - Cancel y
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3DSlicer

&E

Browse to the location of the
Slicer3MinuteDataset

directory.

Select the scene file
slicer3minute.mrml

Click on Open to load the
scene *

CTSA at RSNA 2010

Slicer3 Minute Tutorial:

aNO

File Eat View Window Help Feedback

Load A Scene

Load Scene...

Ctrl-O

Import Scene...

Download Sample Data -

Add Data...
+* Add Volume...

n;m Add Transform...

Save

? Close Scene

Cirl-A

Ctrl-5
Ctrl-w

van Exit

|Maripul

late 30 View

¥ Loading Scenes & Data
¥ Saving Scenes & Data
Adpsting Data Display

Configuring Viewers & Layout

1800

| 2 NN Y=,

'\ 3D Slicer Version 3.6.2

:m

e

) PETCT
) PETCT _Yap1

| @ BhEEMOCEN=E B @ & O

I\ Select File

S Size

I slicer3minute.mrnml 18 KB Thu May 28 10:21:28 2009

Modified ti

) PETCT Yap2

) PienaarGrant

) PNL-Normal-Subjects

) ProfilingTest

) Prostate

) ptest

) RECIST-TutorialData

) RonData

) Ronstest with 4

) Slicer_data
ChangeTracker2009

= o

& Slicer3Minute

= TutorialData

ime

=l

—— -~

—0

Files of type: IScenes(.mm\l xml xcat)

-

T Open

Cancel

Thursday, November 4, 2010




@ Slicer3 Minute Tutorial: Viewing the Scene

AN \ 3D Slicer Version 3.6.2
3DSI|cer File Eait View Window Help Feedback
B [&] s | v [« ] [=] =) _ BNl =Em O 8 & §-
B s
When the scene is finished 3D Viewer

loading, Slicer displays:

* a 3D model of the head inthe 3D | .
Viewer, and ] O
e anatomical MR slices of the brain | 2"
in the 2D Slice Viewers.

S Maripulate Shee Views

EEDOEEERRE @]

“ Manipulate 30 View

& (] Il (] - o

2 LT H 3

pracaie NAS 38, 110 78), Bg Ot of Frame

Sllce Vlewer

g..
S9)[

o[ef
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( ﬁ Slicer3 Minute Tutorial: Viewing the Scene

AaNN \ 3D Slicer Version 3.6.2
3DS|icel‘ File Eant View Window HMelp Feedback
() ()| e [ [IEIE = BRANERECRNEN ©C & & -

Note:

We have pre-adjusted the window and level
settings for these volumes so that they are
appropriate for display on most laptops.

If display is not satisfactory on your
machine or projector, the Volumes Module
may be used to refine these settings.

T WMIBTIDUE SHCE Views

EEDOEEERRE = @

&l (2]
Q L} ta) @‘J 2,

=2 O C

pacaie RAS (1883, .15, .16.9), By LUK (38, 110, 786), By Out of Frame V.
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@ Slicer3 Minute Tutorial: Exploring Slicer’s functionality

AN \ 3D Slicer Version 3.6.2
3DS | icer File Ean View Window Help Feedback
- | A modutes WhANEPEOENEm CEE & - &
r‘\ elice 4 Color
20C r
o ) Data

, Editor

Fiducials

3D Slicex s afee pefBource sowills o

la Measurements

Left click and hold the / b # oei

Modules menubutton. /|- e

A Slices

| “* Transforms

Select All Modules to o okt
display the many modules —
available for image nformtics

Reaqistration

processing, analysis and ' Segmentation
Quantification

3D visualization.
I:JLU.DEE[E@IIH 16T

Filtering
“ M
SOD S o | Surface Models
Converters
& el (2] - =
] -, Endoscopy
L‘H\’ L‘ Developer Tools
.-
4D
GHFICE FAS BSUR 98 hision Weighted 4
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Slicer3 Minute Tutorial: Exploring Slicer’s functionality

800 \ 3D Slicer Version 3.6.2
: File Eant View Window Help Feedback
3DSlicer
- A A A
l’_]] Anades P | 7" 40 Image FetchmMI Python Convert Volume to NUMPY File
> | 7/~ ACPC Transtorm “\ FiberBundles /> Python Load Volume from NUMPY File
A Add Images A Fiducial Registration A Python Numpy Script
Slicer A BRAINSDemonWarp A FiducialSeeding A Python Script
“~ BRAINSFit “* Fiducials “ Python Stochastic Tractography Generator

7~ BRAINSROIAuto - Foreground masking tool ™ Gaussian Blur 7 Python Stochastic Tractography Generator (Labels)
~ BRAINSResample “\ Gradient Anisotropic Diffusion A QueryAtlas
30 Slicer s a ree open source solward 7~ BRAINSVectorDemonWarping \ GradientAnisctropicFilter ROl
D visualizal |/ Binarize Map “ Grayscale Fill Hole \ ROISelect
Mmodule comains ’;’"c Basic Informabien & A ¢, neras “ Grayscale Grind Peak “\ Recenter Scalar to DWI Volume
using Slicer. Please see ou'
" g 7 Castimage “* Grayscale Model Maker “* RegistrationWelcome
. " ChengeTracker / Histogram Matching ~\ Resample DT Volume
3 Slicex CheckerBoard Filter A 1A_FEMesh “ Resample Scalar Volume
10 rera ) arafcai-b 7 ClipModel 7~ 1GTToolSelector ~* Resample Scalar/Vector/DWI Volume
Tha 4 CollectFiducials “* Image Label Combine /> Rician LMMSE Image Filter
‘ 9~ color A JointRician LMMSE Image Filter  “> Robust Multiresolution Affine Registration
B ~ “pmaton panel belod © Convert Fiducials to Labelmap /* Label Map Smoothing /* Robust Statistics Segmentation
T th M d I /> Create Single ROl file  LabelStatistics /> SUVComputation
0 a CceSS e O e S /\ Create a DICOM Series /\ Labelmap Seeding A ScriptedModuleExample
Jule on startup ” CropVolume “ Linear registration “\ SegmentationWelcome ~ W Fwiiae
mOd u Ie b rowse ! A Curvature Anisotropic Diffusion A MIRI Bies Field Correction A Shift DWI Values —
’ . } |~ Data A Mask Image “ Simple region growing
th rou h th e I |St of # Dicom to Nrrd Converter A Measurements ~ Slicerwelcome
g | 7 Diffusion Tensor Estimation 7> Median Filter > Slices
| / Diffusion Tensor Scalar Measurements A Merge Models / Stochastic Tractography
modules... icmconn > oo Conon Sograraton > et imaons
Command-line 7 Model Maker 7~ Surface Connectivity
7~ EMSegmel 7~ Model Transform “ Surface Registration
“* Editor “* ModelintoLabelVolume 7 Surface Toolbox
|' k th } A Endoscopy Threshold Image
LU Or C IC On e { 7 Execution Model Tour # Models )rensiurms
= | Expert R pipimeg Unbiased Non Local Means filter for DWI
models icon s | eviosevoume arsom oMM UMt comacton || O VolumeRanderng
@ E [pl * Extract Baseline DWI Volume * NeuroNav A Volumes

Fast Affine registration Orient Images

:
in the toolbar ) [B] & | e sieteon
© o A

R “\ Fast Nonrigid BSpline registration “\ Otsu Threshold
| ~ Fast Rigid registration /\ Otsu Threshold Segmentation v

prapscaie NAS (1803 21 5 16 5) B UK (4 A EastiarchingSegmentation /\ PETCTFusion y.
" 7~ ProstateNav "

CTSA at RSNA 2010 -
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@ Slicer3 Minute Tutorial: Switching to the Models Module
=

- Yala

3Ds|icer File Ean View Window Help Feedback

1) (Rl IS EIE =

r’\ Slicer

4

¥ Melp & Acknowledgement

* Load

b'] Add 30 model o & nodel dreciory
|

= Add scalar overay

-

Hietarchy & Doplay
od erarc x
B Scoene A
hemisphenic wisle matler.vik
Rft_eyeball vik

oplic_chiasm, vik
oplic_merve Lvik
oplic_marve_R.vik
oplic_tract Lvikx
optic_tract_R.vik

“ Masipulate Shee Views

EEDOEREEEEE

Tk
(G el [B] - ®
y A EH[LT.H".

prayacale RAS (1834, 296 8, 24 8), 8g. Sace not showr

N\ 3D Slicer Version 3.6.2

M (7] (5] (@] [@] &6 ) (@] [7

= TNES N N S N e

- Slicer displays the GUI of the

1 Models module.

£
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@ Slicer3 Minute Tutorial: Basic 3D Interaction

Rn’\
3DSlicer File Eat \View Window HMelp Feedback
Bl (&) e e BIE =
r.\ Slice
=4

feft_eyeball.vik
colic chiasomn.vik

Position the mouse in i
the 3D Viewer. "

Hold down the left
mouse button and

drag to rotate the
model.

]
e e el [ [ (a)
“ Matipulate 30 View

F’RHE =

£ HH[--

N\ 3D Slicer Version 3.6.2

RN CRC I SR )%

Left-click & drag

| = (O] e B &
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@ Slicer3 Minute Tutorial: Viewing Slices in the 3D Viewer
=

AaNN \ 3D Slicer Version 3.6.2
3DSlicer File Ean View Window Help Feedback

B @)| w [ LMEE @ - BREERGOEIEE D & & - O
r.\ Slicer .

4

feft_eyeball.vik
optic_chiasm.vik
oplic_merve_Lvik

oplic_merve R.vik
= ract_Lvik

Click on the o
Slice Visibility f' !
| Icon e

to display the » sxwwes
AXlaI SI'Ce |n [Mag Select

the 3D Viewer "
= e B ) B () (@ ()

“ Matipulate 30 View

F’RHE =

Sl HIL\
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1 @ Slicer3 Minute Tutorial: 3D Visualization

3DSlicer

Slicer adds a view bf the
Axial slice in the 3D
View. LG
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@ Slicer3 Minute Tutorial:
A

3DSlicer

Select the Skin mod/el‘.

Change the opacity of
the model from
1.0 to 0.0.

Yale

B ]| war w—

L)

— hewesphanc_wivls_maiter viK
bt _ayebisdl, v
F—oplic_chesem, vik
—optic_nerve_Lvex
—oplic_nerve Hvik
r—oplic_tract_Lvik
r—oplic_tract Rk

pee R S

{—Skn.vik

Al Vooel Daglay

1]

3D Visualization

\ 3D Slicer Version 3.6.2

MOEE - BRI RCErEm B & &

W
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“(§\ Slicer3 Minut
£

3DSlicer

—
Fle Egm Y

& E - o alole:
s

— heresphonc_wivls_matter. vix
e Tt_aywhadl v
r—oplic_chessm vik
—optic_nerve_Lvek
—oplic_nerve H.vik
—optic_tract_Lvik

The model of‘the skull bone and“.
eyeballs become visible through the
model of the skin in the 3D viewer.

e Tutorial: 3D Visualization

\ 3D Slicer Version 3.6.2

W @) (A @ @] 6 ]

NZI=1ONSIEN IS

(skin model opacity = 0.5)

* Manigulate 3

EEDOENEERE [@]

‘.‘;(

"’[gm
HDD
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L @ Slicer3 Minute Tutorial: 3D Visualization

Yale

3DSlicer —
B B w

)

4

- - OEE®

—hewresphenc_wivls_matter.vik

e Tt_aywhadl v
F—oplic_chessm vik
F—oplic_nerve Lvek
—oplic_nerve H.vik
—optic_tract_Lvik

The model 6f fhe skin becomeé
invisible in the 3D viewer.

(skin model opacity = 0.0)
(skull model opacity = 1.0)

P @

* Manigulate Stice \

ey

EEDDElEER@

“ Manipulate

@@ =
| G w 8] o
< BENE

\ 3D Slicer Version 3.6.2

1@ @ O [@ 7= m 2] 8 &
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@ Slicer3 Minute Tutorial:

3D Visualization

\ 3D Shicer Version 3.6.2

| (@] (@] &l [ [¢] [7] = w] (9] [@ i - [

] B &-
LS

3DSlicer |————— — —
B )| — == M @] [&

(3

B

— hwesphonc_winls_matter.vix
e Tt_ayeball vek
—oplic_chiasm, vik
—oplic_nerve Lvek
—oplic_nerve Hvik
r—oplic_tract_Lvik
r—oplic_tract_ Rk
r—rght_uyutall vik

x | N

—Shan.vik
Seloct Madel oc Heraschy
Selected
=
@ e o + @& <@ - - @]
L }"i" ----- = :_ﬂ{ o :E o ]
* Manigulate Sice Views
EEDOEEEER@
- Manipulate 20 View
(6 (8 I (#) - =
+— RG Ln_nj_gj -
L BENE
8211 89 2.7 t

Click on the
Slice Visibility
icon in the |-~
Green Slice
Viewer

to display the

.. Coronal Slice in
the 3D Viewer.
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e

3DSlicer B
B @) ——

)

-4

Tyt Ve

—oplic_cheasm, vik
F—oplic_nerve LvEk
—optic_nerve_R.vik
—optic_tract_Lvik
—oplic_tract Rk
—raght_sywtdll vik

— Shan, vk
L shall_boew viK
Vodel Daglay
Made
ted
Y ”
t Sat A lar
or Map e
£
Shonintemestensssemie
Ba 0 =]

EEDlElEERE

Manigulate 30 View

) (5 =
[T;j&tﬂ

Slicer3 Minute Tutorial:

HEE®

3D Visualization

\ 3D Sicer Version 3.6.2

HeECocEREEIEEE S

Select the 3D
model
skull_bone.vtk
in the Model
Hierarchy and
turn on the

t Clipping

| option.
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@ Slicer3 Minute Tutorial: 3D Visualization
o

o r

\ 3D Sicer Version 3.6.2

] o MEEE Bpl@PRbRl=Em o @ s 1O
N - :

£

Tyt Ve
—oplic_cheasm, vik
r—oplic_nerve_Lvik
—optic_nerve_R.vik
—optic_tract_Lvik

—oplic_tract Rk
—raght_sywtdll vik

3DSlicer

= !
Browse through the
coronal slices to
expose the 3D

model of the white

e~ = matter, and the left
and right optic
. nerves.

Jap Select

EEDlElEERE

Manigulate 30 View

EFEBE - -
2 o (5] &
rﬂ QI B
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@ Slicer3 Minute Tutorial: 3D Visualization
N \

anr

Niew  Wnoow

3DSlicer

Eot

(&) [F] e o
‘.. Slice
WL ayeta Ve
F—oplic_cheasm, vik

—oplic_nerve_Lvek
—optic_nerve vtk

Select the 3D model o
“skull_bone” in the ! i
Model Hierarchy, and

turn off its Visibility .ea™

9 "
* Manigulate Sice Views
EEDDElEER M
* Manigulate 30 View
(6 @ ) - =
cle iR
(2ll=] (%[

AONE®

\ 3D Sicer Version 3.6.2
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\ 3D Slicer Version 3.6.2

@ Slicer3 Minute Tutorial: 3D Visualization
N

FYale

3DSlicer L e e -
——— AR @

Bl &
£

F—WE_ayubi Ve
F—oplic_cheasm vik

—oplic_tract Rovik
—raght_uywhall vik
— Sk, vik

L shaall_boew ik

Scroll the Coronal Slices to display the .
hemispheric white matter model in the -+ Ewa0mT=7a
context of the image data in the 3D Viewer. | | =¢1) S —

Ie]

PEDDEDEERw @

Maniglate 3O -
(& 8 (]
Holw|CIoRs
(=] (8]

;O

e RAS: (16
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@ Slicer3 Minute Tutorial: 3D Visualization
o

=
3DSlicer
BE - - ool
»
B

G e
| hemisphenic_white_matter.vik
o laf? avahall uik
! oplic_chiasm vik

’I‘ peoplic_nerve Lvik

Select the hemispheric white ..
matter model called °

Views

hemispheric_white_matter.vtk , ,mmam

£

ﬁ‘

Turn off its visibility. @
I&

V’(s l

E@E

oplic_nerve Rvik
f L optic_tract_Lvik
|- optic_tract_R.vik
Fright_eyeball.vik
- Shan.vik
Nodel Duglay
Mdel of Herarchy: | hemispharic_ahite_m

\ 3D Shicer Version 3.6.2

Bl RfEr=Em o @ & -
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L @ Slicer3 Minute Tutorial: 3D Visualization

3DSlicer |

Slicer displays the optic nerve,
optic chiasm and optic tracts

.| overlaid on the MR images of the
brain.
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@ Slicer3 Minute Tutorial: 3D Visualization: Zoom the view
-

A NO \ 3D Shcer Version 3.6.2

3DSlicer

BE) - - DEEE— BpEEE0ErEm e E & i O

® s,

Windows/Linux users: Position the

mouse in the 3D Viewer, hold down the
right mouse button and move the |
mouse down to zoomin.

s -

Mac users: Position the mouse in the |

3D Viewer, hold down the apple !

button and the mouse button and .
move the mouse down to zoom in.

!
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3DSlicer

Slicer3 displays a closer |
view of 3D anatomical .
structures overlaid on 2D ... s
MR slices

CTSA at RSNA 2010

> WY

Slicer3 Minute Tutorial: 3D Visualization

ann \ 3D Skcer Version 3.6.2 H

Fle EOl View Winoow Hep Feemack

BIE) = == MoE@E - BREERMCEIEm B 8 & § -

Oy Scene E
= hemispheric_white_matter.vik

- left_eyeball. vk

b oplic_chiasm.vik

+-oplic_nerve Lvik

optic_nerve R.vik

| optic_tract_Lvik

| optic_tract_R.vik

b rght_eyeball vk

TR /

Madel of Herarchy. | hamisphanc_abite_mater vk

e Inersections Visitle
aclace Cuing 1
et

* Manigulate Sice Views

EEDiEiEER@

* Manipulate 30 View
EEEE - =
=
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Slicer3 Minute Tutorial: Summary

3DSlicer

This tutorial has demonstrated:

e Basic description of the Slicer3 Application Interface
e How to load a scene containing volumes and models
e How to visualize these different datasets together

Next, we will use these building blocks to perform
Image analysis and visualize quantitative results.

CTSA at RSNA 2010
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( u
/ H
</ R 7
o e
/ ; Coronal — 3@ 2008-spgr.nm =<

: i Nene —t | 2l[@)] 20085007 nm_vol_Supsrsameies  —dt |
3DSlicer |l [T ——

CCCCCC

2007

The module described in this tutorial was tested on Axial 3D
SPGR T1 post Gadolinium scans (Voxel dimension: 0.94mm
x 0.94mm x 1.20mm, FOV: 240mm, Matrix: 256 x 256)

CTSA at RSNA 2010

ChangeTracker: exploring small volumetric changes

Part Il: Analyzing Small
Volumetric Changes using the
Change Tracker Module

Kilian M Pohl, PhD
Ender Konugolu, PhD
Andriy Fedorov, PhD
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ChangeTracker: Conventional measures of tumor response
w

3DSlicer

« Conventional anatomic imaging using CT or MRI are often used to evaluate
tumor size and shape

* Most clinical trials that evaluate new chemotherapeutic drugs use changes in
uni-dimensional or bi-dimensional measurements to assess response (e.qg.
RECIST)

» Slicer has several tools for applying RECIST methodologies
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f Quantifying tumor change: Conventional measures of tumor response

3DSlicer

\ 3D Slicer Version 3.6.2
e Em Views W -

Bl &) Ran MrEE  EmﬂﬁﬂEﬂﬂFqiﬂE£&'r@

3D Slicer’s Fiducials Module _
can be used to measure the ............
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Two fiducials may be used to
mark the tumor’s extent.
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. IEEEER @
The distance measurement ...
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Quantifying tumor change: Conventional measures of tumor response

S ANO \ 3D Skicer Version 3.6.2
3Dsllcer ’_V’c Et View Winoow Hep Feemach - —
B )| | wmorem MEEE - BRAPREOFENER B8 & -
{;\ licer 1 Byl 24 X037
- AT ‘ Jii:
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e lerwry

3D Slicer's Measurements module,
provides interactive measurement -
tools that operate in the 3D Viewer ...
and the Slice Viewers.

Display Optians
- Lne Celot
Standard

Annceaton Formats

& Arnotation Format

Interactive ruler can be used |
to measure the longest '«
diameter and provides
numerical annotations

TS Cs
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3D Slicer’s
LabelDiameterEstimation
(extension) module will
automatically compute the
largest tumor diameter and
orthogonal dimension.

This analysis requires an
initial segmentation (VOI).

CTSA at RSNA 2010

LD =38.1 mm

Baseline: June 2006 Follow-up: June 2007
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Lt ChangeTracker: rationale for new approaches
L 4

3DSlicer

* However, more accurate and precise methods for understanding
volume changes may be useful when:

* benign tumor change is being monitored, or

« where small changes may be clinically significant but difficult
to assess with RECIST

« ChangeTracker Module is a tool to measure
volumetric change at the voxel level.
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1 (ﬁ% ChangeTracker: exploring small volumetric changes

P Yats

" Fie  Load Scene... Ctrl-O
3DSlicer = [ Import Scene...
&) i
~ Download Sample Data
e Add Data... Cirl-A
Add Volume...

Add Transform...

First, close any previous . . s

" Close Scene Crl-w

scene. '
/ : Exit

Select File-=>Close Scene

This removes any datasets . _
previously loaded into Slicer. nenEme «

\ 3D Shcer Version 3.6.2
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x
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ChangeTracker: Load the training dataset

AaAnn \ 3D Shcer Version 3.6.2
i/'fmpjfm e ~ BREENOEPNEEEEE 4 1O
Select File->Load Scene - -
This raises the Load Scene Interface

Select Slicer_data from favorites panel. —
& - | — =

I_[__Al LLT (S]]

Select the ChangeTracker2010 dlrectory \q“” YT F—

11 0 Prostate
L ptest
) RECIST-TutorialData
o RonData
) Tempwrite

And select the scene file: }
ChangetrackerTutorial2009.mrml| @
double click the file, or click Open rj

) Ronstest with 4
) Slicer_data
i

) Automatic Segmentation
) DiffusionDataset

M = ) _
j ChangetrackerTutorial2009.mml 43 KB Sun Nov 22 11:36] E

) L‘” LL_J (= ) FreeSurferTutorialData
U ) LiverData
L‘ ) Neurosurgical Planning Tutorial D¢ /
N — 1
VVVV me: KerT
=
Files of type | xml

— = I =
Open

7e{ A
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ChangeTracker: about the data...
w

3DSlicer
This course is built upon two scans of a patient with meningioma:

MR Scan 1 MR Scan 2

Please note: we have pre-adjusted the window and level settings
for these volumes so that they are appropriate for display on most
laptops. If display is not satisfactory on your machine or projector,
the Volumes Module may be used to refine these settings.
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w

3DSlicer

Baseline:
June 2006

Follow-up:
June 2007

ChangeTracker

- Clinical context

Meningoma
e Usually benign slow-growing tumors

Baseline radiologist’s clinical impression:

* large falcine lesion is identified.

e measures 3.1 cm anteroposteriorly, 3.05 cm from
side-to-side, 3.5 cm in height.

e enhances moderately on post gadolinium imaging.

Follow-up radiologist’s clinical impression:

e left frontal lobe mass appears unchanged on all series.
e measures 3.3 x 3.2 cm in maximum dimension.

e enhances moderately on post gadolinium imaging.

How has the tumor changed?

Thursday, November 4, 2010



ChangeTracker: exploring small volumetric changes

.00 \ 3D Skcer Version 3.6.2

3DSlicer

Eﬂﬁrjﬁﬂjrqrjﬁﬂ it B
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4
o Conventional layout

Change Layout to “Four-up”:
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) 3Don1y|ayou(
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ChangeTracker: exploring small volumetric changes

/ o no \ 3D Skicer Version 3.6.2

BE] [ - ! Modules g PR EREEDEEL S

“* Color po -1 -
] S > T == =
// S lice Data v =7 ] —

3DSlicer

Editor
/) -
‘ Fiducials
Nodel Daglay Measurements
Select Madel o Merarchy & NModels

* ROI

* SlicerWelcome

Using the Modules/Menub'utton,

Transforms

Select the ChangeTracker Module  ~ veunerenaems
- Volumes
from the Wizards category. < —_
¥ izards | % ChangeTracker
pacey Infarmation R st "
Registration - —— ~@ - -5 -
Segmentation - :% e Eg N— -
Matenal Propemes Quantification -
Armbient Diffusion -
DMuse IGT -
Filtering -
Surface Models -
 Manigulate Sice Views Converters -
EEDDEDEEpE oo .
Developer Tools -

* Manipulate 20 View
4D
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ChangeTracker: a note about the Workflow Wizard

3DSlicer

¥ Help & Acknowledgement
Step Panel__ 1/4. Define Scans
A Workﬂow Wizard gUideS Selectfirst and second scan of patient
the user through a sequence [ Setectsean |
of steps and has the 1 sean | None — I

following components: User Panel-- || % Seen None = 5
 the Step Panel
e the User Panel
 the Navigation Panel Navigation Panel--

CTSA at RSNA 2010
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ChangeTracker: First step: select scans

\. 3D Skicer Version 3.6.2

annm
3DS|icer Fle Eot Viem Wintow Hep Feemach
B )| e [ e MEEE - BREElEOEEm e @ & -
{D Slicer ChaméeTTracker ~~ - 2 e . '

- PIEL=] I

Cd)

0

Select baseline & follow-up studies:

Scan 1 = 2006-spgr
Scan 2 = 2007-spgr

-
e -
v - =
- .
- -

* Manipulate Sice Views

EEDOEDEER@ @]

* Manipulate 30 View

[ EEEE ,

«
1.9, 131.3), By Sace notshown

2006.4pgr nivd RAS

CTSA at RSNA 2010
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ChangeTracker: inspect the tumor

Yale \ 3D Shcer Version 3.6.2 .
3DSlicer === e Move sliders in Slice
&) )| s | eowemnn MOEEE - BRAEPROEDEm D 8 A - .
> E - % - i Viewer Control panels
4 Slicer ] oo ={ ] o g v Z 1
- ci=a to get a close-up view
— of tumor in Axial,
[Ee—— Sagittal and Coronal
' e slice viewers.
Zoom in (Right mouse
% down and push/pull).
=L
i :
Pan (Middle mouse
— down and move).
EEDDEEEEEE N
=@ B )
‘R [l (2
" [.T_] » |8
6.5p d 6 1 o y-

CTSA at RSNA 2010 -
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ChangeTracker: Step 2. Define a volume of interest

A NO \ 3D Siicer Version 3.6.2

B C—

3DSlicer A VOI Box W_i_c-lg—ét—ié-positioned within the image volume in the 3D
viewer, and the VOI’s intersection with each slice is shown in blue.

¥ Help & Acknowiedgenent

26 Detne Volume of nlerest

Ack right mouse bution % re.center VOL use lef bution to

Dedne v
Daplay volume rendenng and Vot label B .....

96 4

ge an

| = |
240
A Rge

: g4
%6

ge ' )

Center the VOI first: ] et

Right mouse click in the L
tumor center to position the m&mew

VOlI displayed in blue in each

Slice Viewer. S0 =

CTSA at RSNA 2010
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ChangeTracker: Step 2. Define a volume of interest

A00 \ 3D Shicer Version 3.6.2

Bl @] = [_ewerree- MNE® BRplepliFEI=Em D0 E & 1O
@ Slicer i J m:”‘- gz n.:-:?-l :

3DSlicer

¥ Melp & Acknowtedgenent 78 [0 - :
“ Wizacs
¢ Dedne Volume of nlerest

Chck right mouse bution 55 re<center VOL use bk bution to

Dedne VOI
Duplay volume rendenng and vOi label E] »»»»»

* ROt Wiaget Controts. RAS Space

‘ — . View the VOI box widget and
1L oo swsos (5] e S % volume rendering of tumor
Next, resize the VOI: | =1 : in yellow in the 3D Viewer

Left mouse click in any ..
Slice Viewer to change |
the VOI extent g2 ~

20065pgr NiTd RAS (64.8.24 8, 78 14), Lo Sace notshown , Fg. Shoe net shown, By Sice notshown v y-

E@ ) @]

CTSA at RSNA 2010 -
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ChangeTracker: Step 2. Define a volume of interest

Fine-tune the VOI using the VOI Widget range sliders
or by moving the VOI Widget handles in 3D view

“* Wizard

2/4. Define Volume of Interest
Click right mouse button to re-center VOI, use left button tc

- Define VOI

I-S Range: ;

Display clipping box E Interactive Mode @

Note: VOI Widget range sliders are color-coded to match
VOI box Widget handles in 3D Viewer

CTSA at RSNA 2010
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ChangeTracker: Step 2. Define a volume of interest

ANN \ 3D Skicer Version 3.6.2

Fle EOt Vs Wintow Hep Fee

BIE)| | o [ @

3DSlicer

BplepRbERi=Em oc @ s -
-l® - -

. 5 won
-

¥ Hels & Ackrowiedgenent

Scroll through slices ..
to ensure that tumor  “ e

Dedne VOI

boundaries are ... 5 e
included in the VOI. =

2
LA Range n n

Click Next

* Manipulate Sice Views

EEDOEREERE

“ Manipulate 30 View

L EEBE =
" cull EJJ W P =,
oA mc_._

.
2006.5pgr NiTd RAS (64.8.24 8, 78 4), Lo Sace notshown , Fg. Shce net shown, By Sice notsho
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ChangeTracker: Step 3. Segment the tumor
=

w

3DSlicer

l

Make sure that the volume called
2006_spgr.nrrd_VOI_Supersampled
is selected in the background layer
...and...

:'_'i- 2006_spgr.nrrd_VOI_PresSegmented

is selected in the label layer.
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3DSlicer

ChangeTracker: Step 3. Segment the tumor

A N\ 3D Slicer Version 3.6.2
E R Pra——— [T TIE {_ﬂ Qﬁ Tﬂ ;’.:.’. [Q ] ‘uf 17 J[ .._.{ ‘- o— \-. } 3D Vlewer ShOWS

— % model of tumor
]z werws vox mesesmanes = e e
[#

&

Slice Viewers show

: L= R % .. VOI with current e
Modify the e ch segmentatlon overlay -
segmentation by = e 0N light yellow
moving threshold LI

range slider yjgpoenemsw @

* Manipulate 20 View

=R
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E2E
9 ‘-\,&

PlEE
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®
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3DSlicer

T )

* Manigulate Sice Views

EEDOEREEREW

“ Manipulate 30 View

~
®

O sl

Iz
HDD

AOE®

ChangeTracker Step 3. Segment the tumor

\ 3D Slicer Version 3.6.2

BN REm D08 & 1 -&

E o s\ e—
T —— 2 g e —
g

Scroll through the
slices until the

: : 9 —== segmentation
'eJ’”“” = REL == ~appears optimal.

Press Next.
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~mn

A
Fle

@ ChangeTracker: Step 3. Segment the tumor
N

\ 3D Shicer Version 3.6.2

3DSlicer

BE - - - AEEE— BREPEOEDSE EEE s -0

Slicer

3
g

Press the Slice option ...

: ~ -0
— 1) ey v —

SEL]

to view the volume .%5....
rendered segmentation .o
with the axial Slice | s on
together. =
\

If you need to reset the
3D View, try using the

Axis Navigator 'wwwsewm
Widget. PEDDEDEERW

P Manigutate 30 View

S , L{;ﬂﬁE@J ~ [ .
‘) Joal (5] = m=g
N 2O —
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ChangeTracker: Final step: Select Metric

(2
Fle

w

3DSlicer o e rew T
- PUE—— F T] E m

Metric Options:

Detect change by ~ “"
analyzing intensity ...
pattern (fast) ..}

Reavire gromth

Measure change by ‘
analyzing
deformation map /
(slow)

* Manigllate Sice Views

Select fast and press

Analyze |
) o)L -'-i
LSl

[@]

\ 3D Slicer Version 3.6.2
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sl E—
28 -

el

Thursday, November 4, 2010




ChangeTracker: Intensity-based analysis details

w
3DSlicer Konukoglu et al. ,“Monitoring Slowly Evolving Tumors”, ISBI, 2008

e

Register baseline and followup (preserve volume) b ‘w‘ !!
= ] 'L | q.

Normalize intensities i A/ 2{

Using segmentation and difference image,
compute PDF of dormant tissue

Set threshold for voxel-wise analysis
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@ ChangeTracker: Results: change in pathology
A

ANOD \ 3D Shicer Version 3.6.2

3DSlicer

|[B] (B e | cnormene ME® ' BoleEpEbERl=m Cc @ & 1O
Change in volume is shown = - I R
overlaying the tumor image e
and in the 3D Viewer:

magenta = growth
green = shrinkage
Note: Analysis is
displayed in the
“Compare View” — . i B

layout with linked [®] meooEnEme s sl 00

— /

control for the | v
Lo | [0 -
compare Vicivers. L odes-= S8
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ChangeTracker: Results: change in pathology

. / o no \ 3D Sicer Version 3.6.2

- Fle Eot WViem Winfow Hep
3DSlicer

=8
Iy —

¥ Help & Acknowledgenent

Select visibility icon|? Jto ~ .
show axial slice in the 3D
Viewer.

_ b Sice Views ] - ; ‘m
EEDDEDRERW | OEE

20065pgr nird_VOL_ScperSanpies RAS: (53, 39.9, 37 9), Bg 1< (51, 22, 691 Lb 14 avery, 89 77.0
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@ ChangeTracker:
g

3DSlicer

“Compare View”
layout displays:

eAxial slice & 3D View

*Five corresponding
consecutive slices for
the VOI in the baseline
(top row), and

*in the followup (bottom
row).

Results: change in pathology
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ChangeTracker: Results: change in pathology

SDSTCEIR Crosshairs in Compare View show corresponding voxels in
baseline and followup scan for voxel-wise comparison.

Thursday, November 4, 2010



3DSHcer

Modify sensitivity of intensity
pattern analysis

CTSA at RSNA 2010

¥ Help & Acknowledgement

“ Wizard

Analysis
Analysis of Tumor Growth

- Intensity Pattern Analysis

Sensitive [ Moderate Robust

Shrinkage: 142.828 mm® (116 Voxels)
Growth: 300.034 mm*® (243 Voxels)
Total Change: 157.206 mm*® (127 Voxels)

- Save

IScreenshot H Analysis H Data

Results will be saved to directory:

l:l C:/Documents and Settings/wjp/Local Settings/Temp/Slicerj

| Gia | Sice | <Back |

|

ChangeTracker: Exploring small volumetric changes

sensitive

Intensity Pattern Analysis
@ Sensitive [/ Moderate ["] Robust

Shrinkage: 243.458 mm* (197 Voxels)
Growth: 327.234 mm* (265 Voxels)
Total Change: 83.776 mm*® (68 Voxels)

moderate

Intensity Pattern Analysis
Sensitive [ Moderate || Robust
Shrinkage: 164.717 mm* (133 Voxels)

Growth: 266.577 mm® (216 Voxels)
Total Change: 101.860 mm® (82 Voxels)

robust

Intensity Pattern Analysis
Sensitive [/ Moderate [ Robust

Shrinkage: 116.475 mm* (94 Voxels)
Growth: 186.418 mm* (151 Voxels)
Total Change: 69.943 mm*® (56 Voxels)
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@ ChangeTracker: Exploring small volumetric changes
-

B

3DSlicer /

Click on the coloreci‘bar at
the top of any Slice Viewer
to show or hide the controls.

This allows more display
space for viewing the image
data.
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Lt ChangeTracker: Exploring small volumetric changes

3DSlicer

Tested on Axial 3D SPGR T1 post Gadolinium scans (Voxel dimension: 0.94mm
X 0.94mm x 1.20mm, FOV: 240mm, Matrix: 256 x 2506).

Tumor boundary should be clear.

Only for contrast enhanced images.

Need homogenous enhancement across timepoints.
Not tested for tumors with changing necrosis.

Correspondence between Intensity-based and deformation mapping-based
analyses should be checked.
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ChangeTracker: exploring small volumetric changes

3DSlicer

This tutorial demonstrated:

e a method to quantify small volumetric changes in pathology.
e visualization of these changes in the anatomical context

e use of Slicer’'s “Compare Viewer” to simultaneously explore baseline
and followup studies.

Next, we will demonstrate combined visualization
of PET/CT studies and SUV computation.

CTSA at RSNA 2010
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@ PET/CT Visualization and Analysis
=

.
3Dslicer | Axisl : PET1 - :
‘@ e

Part lll: PET/CT Analysis
using 3D Slicer

|-52.557

Jeffrey Yap PhD
Ron Kikinis MD
Wendy Plesniak PhD
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F%ﬁ PET/CT Visualization and Analysis: Start fresh.

\ 3D Shicer Version 3.6.2

P Yats

3DSlicer X
e
First, close any previous
SCene. :v"»"".: Je
.

Select File-=>Close Scene

This removes any datasets . _

previously loaded into Slicer. maw:m )

1
&

ROl =]
= == =

at = & -
10, =L =1

® &l

PEE e E A

“
o

} &

® =] I‘-f;.l

ool
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3DSlicer &

Download Sample Data P
Add Data... ctrl-A
- I - Add Volume...
Select File->Load Scene [ wreen.
" Close Scene crl-w
5
[8e Bt
1. Scar "
2 Scan N

This raises the Load Scéﬁe Interface

select the file called
PETCTFusion-Tutorial-Scene.mrml

Double click the file, or click Open |

* Manipulate 30 View

E@EBE -
. ‘R el (2]
" I"T_] 2|8 e
20065pgr nird_vOe_SuperSangies RAS (83,217, 31,91, Bg 14

a (e WA £ He o Ruct
PR @

\ 3D Shicer Version 3.6.2

0N
v N MM Y=,
) plest
) RECIST-TutorialData
) RonData
) Ronstest with 4
B () Slicer_data

B ) PETCTFusion-Tutoriall

PET/CT Visualization and Analysis: Load the new scene

BRleRp b= 58 & O

\ Select File

e e
o cn
) CT2

) PET1
) PET2

/]

[ L p
O cr2
5 PET1
) PET2
) Results
1 ) Slicer3Minute
{ () SlicerTesting
) TutorialData
) Visualization
) Wstruct

Wed Dec 16 18:33:
Wed Dec 16 18:32:
Wed Aug 18 13:55:
Wed Dec 16 18:32:

~l

N_—1 b=

| File name: [PEFCTFusion-Tutonal-Scene mrml
A

CTSA at RSNA 2010

" Files of type. [Scencs .mrml xml xcat)
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PET/CT Visualization and Analysis: About the data
w

3DSIi .
e Non small cell lung cancer patient

Two PET studies: baseline acquired before treatement, and followup
acquired 1 month after chemotherapy

Two non-diagnostic CT images are acquired without the use of contrast
FDG-PET scans acquired 60 minutes after intravenous injection of

approximately 20 mCi of 18FDG

Two VOIs have been created using Slicer’s Editor Module.
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or

w

3DSlicer

Using the Modules &7 e
Menubutton:
Expose the menu

and select the
module called
PETCTFusion under -...
the Quantification -
category. P ‘

* Manigulate Sice Views

EEDDREDEERA

* Manipulate 30 Vie

Quantification ,»\ LabelStatistics ! 12 |-34241

PET/CT Visualization and Analysis: Open the PETCTFusion Module

\ 3D Shicer Version 3.6.2

All Modules

Color

Data

Editor
Fiducials
Measurements
Models

ROI
SlicerWelcome
Slices
Transforms
VolumeRendering

Volumes

Wizards

Informatics

Registration

Senmantation - PERTee

Diffusion ~ | @ PETCTFusion '

IGT ~ | 77 SUVComputation
Filtering
Surface Models
Converters
Endoscopy

Developer Tools

4D
Diffusion Weighted
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ﬁ PET/CT Visualization and AnaIyS|s Select baseline study

AL3D Skcer Version 3.6.2

3DSlicer Note: Module requwes DICOM format data TR e
In the Data Fusion panel, D =
select:
CT volume: CT1 po
PET volume: PET1
Tumor Mask: PET1-label

TIEWFH_H;:]B a @]

When the PET volume is selected, a “wait message” will be
displayed while parameters are read from DICOM header.

‘[8&]
B

@
gl
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[B\ PETICT Visualization and Analysis: Information displayed in “Layers”

3DSlicer

\ 3D Shicer Version 362

. : M= BB alsl sl el s mL CLeLEL L § - [0
Note: this stacks the PET, CT ——— ] |
and VOI in three layers: — ‘ l

Background = CT1
Foreground = PET1
Overlay (Label) = PET1-label .. .

where they can be blended into C— o ia 7

a single wsuahzatlon
P

TIEHEHFFQB ) @

(o)

sz
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@ PET/CT Visualization and Analysis: Adjust display of the baseline study

3DSlicer

In the Display Panel, choose
a colorization option for the

\ 3D Sicer Version 3.6.2

]

BRI =Em Be 8 & 1o

ol |
oL I

-» »
v @ =) v
. T P @ N
2 \' 1, n B
) 5
: 2 &

3 5

PET volume from among /=

Grey, Heat, or Spectrum.”

Adjust the window and level
for CT1 and PET1 volumes.

mﬁh
WS

Adjust the Slices Fade Scale s

to jointly display the datasets
in the foreground and
background layers.

(B @l (5] &

-t D el [B)
s R e
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@ PET/CT Visualization and Analysis: Explore the visualization

3DSlicer

Explore:

in the Slice Viewers, |
scroll through the slices
to locate the green Tumor -
label and the yellow Liver -
label.

Note: (the yellow label is
used only to demonstrate
multiple-VOI functionality).
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P Yale

3DSlicer
ELELL s

Shortcut: To view the ...

Tumor Label in all Slice |
Viewers:

Enter =740 in the Axial -
Slice Viewer’s Slice -

( {% PET/CT Visualization and Analysis: View tumor in all slice viewers

\ 3D Sicer Version 3.6.2

18 Heat

Number Entry

..and.. Immm - = 8 .= =
-54 (Saglttal) 0| ||E L - )
103 (Coronal).i gl N

These are (mm)
positions within the |
reference frame of the 1@ @i
image volumes. zﬁf’

mb

WFHTFFE @ (@]
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3DSlicer

In the Quantitative

Measures panel,

click the Compute/

Refresh button.

SUVmax and
SUVmean for
each VOI
(represented by a
different color in
the label map) will
be displayed in
the table.

\

o

—
File Eom v
] [ - AOE
s
Shuoy Da
Capa
PET [
Ir
* QuanMative Measures
b B.01%038 2.neny
o 36305906 200064

—
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_]IE[_XEH_]FI] Q [u]

Manigal
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3D Shicer Version 3.6.2

PET/CT Visualization and Analysis: Compute SUV for all VOIs in baseline

RFIS]

s
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L ﬁ PET/CT Visualization and Analysis: Compute SUVbw for follow-up study

3DSlicer )
| &) & - M= = . BpodERpebEn=Em 0 E & 1O
Look for response to g
treatment in the follow-up e |
study: rm— . :
In the Data Fusion panel,
set: |
CT volume = CT2, u - _
PET volume = PET2 and — 8 5
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Tumor Mask = PET2-label. -
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PET/CT Visualization and Analysis: Modify display of the follow-up

w

3DSlicer

A NO \ 3D Shcer Version 3.6.2
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Adjust the display for..
the follow-up study.

You may want to adjust

the Slices Fade Slider-

and manipulate the 3D
View to refresh them.
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PET/CT Visualization and Analysis: Compute SUVbw for follow-up

\ 3D Shicer Version 3.6.2
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In the “Quantitative Measures” Panel:

select Compute/Refresh to compute

SUVbw for the green Tumor volume (and
yellow liver volume).
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PET/CT Visualization and Analysis: Assess response wrt this VOI

3DSlicer

Pre-Treatment Max SUVbw = 8.0
Post-Treatment Max SUVbw = 9.4

+16.61% (SD)

CTSA at RSNA 2010
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PET/CT Visualization and Analysis: Appropriate Use

3DSlicer

Still validating this module against performance of commercial systems.
Appropriate only for DICOM PET studies only

Not compatible with Philips datasets

CTSA at RSNA 2010
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@ Workshop Summary

3DSlicer

This workshop has demonstrated:
 Basic scene loading and visualization using 3D Slicer

e Use of Slicer’s ChangeTracker module to assess small
changes in tumor size

e Workflow to make quantitative measurements of SUV
(body weight) in Slicer’'s PETCTFusion module
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Workshop Summary: Slides and Datasets

3DSIi§er
Tutorial Slides:
http://wiki.na-mic.org/Wiki/images/4/4e/Combined-RSNAQ09-WJP.ppt

Tutorial Data:
http://wiki.na-mic.org/Wiki/images/5/51/Slicer3MinuteDataset.zip
http://wiki.na-mic.org/Wiki/images/f/f8/RSNA-ChangeTracker-Tutorial-Data.zip
http://wiki.na-mic.org/Wiki/images/7/73/PETCTFusion-Tutorial-Data.zip

Tutorial Software:
http://www.na-mic.org/Slicer/Download/Snapshots/win32/Slicer3-3.5-
RSNA-2009-11-06-win32.exe

More Information:
http://www.slicer.org

CTSA at RSNA 2010
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